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OVERVIEW \

Congratulations on your purchase of Jiose Printer. Jiose is
your loyal business partner offering commercial solutions to
batch label printing.

Please take a moment to follow this user guide as incorrect
operation may result in unsatisfactory print quality, lower user
experience, or even damage to your printer or injury.

aEEEER Highly Recommended: Watch the
Quick Setup Video!

In the USB drive included with this label printer,
there are short videos. It will guide you on how
to set up the printer in a way that best suits your
L 11111 needs. You may also visit our website
wwwi.jioseprinter.com, which offers FAQs, live
chat, and phone calls to help solve some
problems quickly.




PACKAGE CONTENTS \

Check that the package contains the following items before
using the label printer. If any item is missing or damaged,
please contact us.

\
Label Printer Fan-fold Labels User Manual

= B

Power Adapter USB Cable  USBDrive  USB Type-C
Adapter

» Note

The USB drive contains the Windows/MacOS drive file with
Installation Guide, Printing Setup Guide and after-sale contact
information.




MACHINE COMPONENTS \

- Inner View Printer Head
Mechanism

Paper Feeding
Guide Rail

» How-to Open:

Press the both Push Buttons on the side at the same time to
open the printer.

- Rear View

Feed Button Paper Feeding
Guide Rail

SB Port
Push Button

Power Button



PRINTER CONNECTION \

(V] (X » Warning

Make sure the printer is OFF (O=OFF)
before plugging in the power cable.
OFF ON Otherwise, it will affect the service life.

1. Ensure the printer poweris 2. Connect the power cable
OFF (O=O FF) (Make sure your adapter is connected

to the power cable tightly.)

_ —

3. Connect the USB cable 4. Turn the power ON (I=ON)
(If your computer has only Type-C
interface, please use a Type-C USB
cable or USB-C to USB Adapter.)




LED LIGHT INDICATOR \

Light

Solid Blue

Description

Normal operation

Troubleshoot

Flashing
Blue

Printer head is
overheated

The printer 1ob will
resume itself after
cooling.

Flashing
Red(once per
second)

Paper shortage

Reload label to
check if label is
loaded correctly.

Flashing Red
(twice every
second)

Cover is not closed

Close the lid properly.

Solid Purple
(or white)

Firmware upgrade
mode

Restart the printer to
restore normal.

Flashing Purple
(or White) with
beeps

Wrong power
adapter

Use original power
adapter or contact
customer service.




LABEL SETUP ‘

Label Standard Size

L] [ ]
3"Xl" 2X1”
37X2" 2"X2"

33"

47X4"

4"X6"

1.Automatic Label Identification
(Load label without opening the printer)

(1 Connect the printer to the power and turn it on,

(2) Adjust the guide rail (refer to picture a).

() Insert the label deeply and straightly along the guide rail with no
gaps or deviations (refer to picture b).

(@) Once the printer detects the label, it will automatically catch the
label and roll it back and forth. When finished, the label will be
positioned at the tear-off point.




LABEL SETUP ‘

2. Run the Intelligent Label Study

@ After the Automatic Label Identification, press the Feed Button
until you hear one beep, then release it (refer to picture c)

@ The printer will move the label back and forth at the previous 2
joints of the label, to study the label size, thickness, and gap size of
your label (refer to picture d).

(3 After studying the label, the printer will be positioned at the tear-off
point so that not a single sheet of paper is wasted.

@ Then the printing can begin.

» Note
Every time you change the label size, please run the Intelligent

Label Study before printing.




FEED BUTTON MODE \

Desired Action

Execution

Print test page

Press and hold the Feed Button until
hearing two sounds of "beep" and "beep
beep". Or directly click to print a test page
in the printer settings of the computer.

Automatic Label
Identification

Insert label. Press and hold the Feed
Button until hearing a "beep".
*Anytime you change your label, run
the automatic identification of the
label size.

Restore factory
setting

Press and hold the Feed Button until
hearing three sounds of "beep", "beep
beep", and "beep beep beep".

Skip a label

Press the Feed Button while the printeris
on standby. (i.e. nothing is being printed)

Pause printing

Press the Feed Button while printing
many sheets.

Resume printing

Press the Feed Button to resume printing.




DRIVER INSTALLATION
FOR WINDOWS & MACOS

Thermal Label Printer Driver Installation for Windows

The following is a picture example of the installation steps of the thermal printer
J500/J500BT (Automatically identify the printer model.)

. Insert the USB drive that came with the package.

Il. Open the Windows Driver folder to get the drive file and install it with
the following steps (or visit our website: www.jioseprinter.comto get it).

» Note
Make sure the label printer is connected to your computer
with the USB cable and turn it ON (I=ON) before installation.




01. Double click the Windows driver file to install it.

| J500 Driver Installation Guide for Windows.pdf
J500 Printing Setup Guide for Windows.pdf

J Jiose-Windows-Driver-Latest v1.3.1 e‘

02. Click "Yes" to allow the installation.

J Setup - Jiose-Windows-Drver-Lstest v1.3.1 -

Ready to Install
Setup is now ready to begin instaling Jiose-Windows-Driver-Latest v1.3.1 on your
computer.

Click Instal to continue with the instalation.

English




Then, it will display as shown below. (The port will be automatically
filled out as USB0O01, could be USB002, USB003, etc.)
Note: The driver wizard can automatically identify the port. Avoid manually

selecting from the listed ports below unless you are familiar with how the ports
work between the computer and printer.

Driver Name:  |Jiose J500 Default Printer
Detect USB Port

Automatically filled out

Tips: if program can't find
button to get current USB

COM1 Local Port

comz: Local Port

com3: Local Port

COM4: Local Port

FILE: Local Port

LPT1 Local Port

LPT2: Local Port v
< >

Printer Disconnected! .

03. Click the "Install Driver Now" as the arrow pointed. Finally, the
page will display "Add Printer Successfully!"

Printer Modet
Driver Narme: Defaut Printer

Port ‘usnom ‘ ‘ Detect USB Port
Tips: if program can't find USR_nart icallu_olease dlick [Detect USB Port]
button to get current USB {Tips X r port in the st below.

h

port Add Printer Succestully! Type
SHRFAX: Moritor Port
comt. Local Port
comz. LocelPort
comz Local Port
coms: Local Port
FILE Local Port
Lot Local Port
Lom2 Local Port v
< >
[netaling dier




OK, the driver installation is finished, you may close the window and learn
how to set the parameters to your most used or try to print a sample
shipping label.

» Note

If the printer is not connected, your computer will be unable to
detect the port when you click "Detect USB Port" Instead, it will
display a message that says "Printer Disconnected!"

Driver Name: | Jiose J500 Default Printer
E e ad 1ICD e TIR) Lk [Diatact LICD Dol
Printer Model:  |Jiose J500 N
Driver Name:  |Jiose J500 Default Printer
Tipes if prevgram can't find USHRSEY icalhe olasse dick [Detect USE Port]
button to get current USB pq Tips X pter port in the list below.
A~
Port Printer Disconnected! Type
SHRFAX: lax Monitor Port
COM1: Local Port
COM2: Local Port
COM3: Local Port
COM4: Local Port
FILE: Local Port
LPT1: Local Port
LPT2: Local Port e
< 2>
Install Driver Now! ‘ ‘ Exit
Printer Disconnected!




At this point, connect the printer to your computer using the USB
cable and turn it on.

Then, click "Detect USB Port" again and the USB port should be
detected normally.

Driver Name: | Jiose J500 ] Default Printer

Detect USE Port

<

|

i o Eed g 3

Driver Name:  |Jiose J500 [ Default Printer

Port: Detect USB Port

H

Tips: if program can't find USE nort aut ticalby_nlease click [Detect USE Port]
button to get current USB pq Tips X ter port in the list below.
”
Port Printer Disconnected! Type
SHRFAX: ax Monitor Port
COM1: Local Port
COM2: Local Port
COM3: Local Port
COM4: Local Port
FILE: Local Port
LPT1: Local Port
LPT2: Local Port e
< >

Install Driver Now!

Printer Disconnected!

Click it to continue the

installation




Thermal Label Printer Driver Installation for Mac

The following is a picture example of the installation steps of the thermal printer
J500/J500BT (Automatically identify the printer model.)

I. MacOS Driver installation

01. Insert the USB drive that came with the package.

02. Open the Mac Driver folder to get the driver file (or visit our
website: www.jioseprinter.com to get it).

» Note
Make sure the label printer is connected to your computer
with the USB cable and turn it ON (I=ON) before installation.




03. Double click the Mac driver file to install it.

s 7

E J500 Driver Installation Guide for MacOS. pdf

I} J500 Printing Setup Guide for MacOS.pdf

B Jiose-Mac-Driver_v1.2.2.dmg ‘

04. It will show as below. Then, double click the " JiosePrinter-Driver. pkg"
as the arrow pointed to install the driver.

I J Jiose-Mac-Drivervi.2.2

Jiose

. . Double Click
1. Open Installation Guide 2~ JiosePrinter-Driver.pkg’ to install 3 prine Sample to test

‘ N
How to install Jiose Printer JiosePrinter-Driver.pkg Sample.pdf
driver.pdf

Get help: www.JiosePrinter.com




» Note

It may display a message that the file can't be opened. Don't worry, you

just need to perform the following steps to grant access.

(You can skip this part if you don't see this message or if you already know how to install

a third-party software on MacOS and prefer to do it in your own way.)

(7 J Jiose-Mac-Driver_vi.22

“JiosePrinter-Driver.pkg" can't be opened
because Apple cannot check it for malicious
software.
This software needs to be updated. Contact the
developer for more information.

1 ~ Open Installation Guide

This item is on the disk image “Jiose-Mac-

(_Howto install Jiose Printer JiosePrinter-Driver.pkg

Sample.pdf/

(. Select "System Preferences" and open it.

@. Click the "Security&Privacy" as the arrow pointed.

e 0 < System Preferences Qsearch
General  Desktop & Dock Mission Siri Spotlight  Language Notifications
Screen Saver Control & Region
@ = 0 . o
Internet Users&  Accessibility Screen Time Extensions  Security ‘
Accounts Groups & Privacy
@ 0 & & —
Software Network  Bluetooth Sound Printers &  Keyboard ~ Trackpad Mouse
Update Scanners
! - i~ A @ i
Displays Energy  Date&Time  Sharing Time Startup
Saver Machine Disk




@. Click the "Open Anyway", then you can continue to install the driver.

T FileVault  Firewall Privacy

Change Password...

@. Double click the JiosePrinter-Driver. pkg again to install the driver.
Then, it will show as below, just please click it to continue.

The driver files will be copied to the path: /Library/Printers/Jiose/

Click it to continue

— 17 —



Standard Install on “Macintosh HD"

+ Introduction This will take 76 KB of space on your computer.
« Destination Select Click Install to perform a standard installation of this software
® Installation Type on the disk “Macintosh HD".

Installation

Summary

Go Back tall

05. Click "Install Software" and "Install" after entering your
Username and Password.

Standard Install on “Macintosh HD"

® Introduction This will take 76 KB of space on your computer.
« Destination Select Click Install to perform a standard installation of this software
o Installation Type on the disk “Macintosh HD".
ATEMON VRS |
o Instl

Installer is trying to install new software.

L oo pmsomaoston i

Username: JIOSE |

Password: || |

| Cancel

Location...




Finally, it shows the driver is installed successfully. Please click "Close" to

finish the installation.

(@ ® O ‘& Install JiosePrinter Ver1.2.2
The ir was leted ally.
@ Introduction
» Destination Select
@ Installation Type
@ Installation
® Summary

The installation was successful.

The software was installed.

At this moment, the driver has been installed. In addition, it still need you
to add the printer to your Mac.




Il. Add the Label Printer

01. Select "System Preferences" and open it.

02. Select "Printers&Scanners" as the arrow pointed, and click it to open.

System Preferences l QSearch l

ran

Software Network Bluetooth Sound Printers & Keyboard Trackpad Mouse
Update Scanners
T c [
- N:, @ o
- 7 &
Displays Energy Date & Time Sharing Time Startup
Saver Machine Disk

Printers & Scanners

No printers are available.
Click Add (+) to set up a printer.

click it to add a new printer.

Default printer:  Last Printer Used

Default paper size:  US Letter ?




04. The "Jiose J500" (Automatically identify the printer model.) will
appeared automatically, just click it to contiune. And it will show as below.

(¢ Add 0
= =
= @ = 2
Default 1P Windows Search
‘Nlmn ~ Kind
| JIOSE J500 use

‘ 3

|
|
( NN ) Add
- (Q search
P Windows Search

Name v Kind
| JIOSE J500 use
Name: | JIOSE ]

Location: | JIOSE

Use: Choose a Driver...

Software for this printer isn't available from Apple. Contact the printer’s
manufacturer for the latest software.

Add

» Note

Please turn ON the label printer so that your computer can recognize it.
If Jiose J500 (Automatically identify the printer model.) not show up in Mac
after installed, please re-connect the usb cabel to your Mac.




05. Then, click the "Select Software" in the "Use" drop-down box.

Name v Kind
JI0SE 500 uss
|
|
Name: | JIOSE J500 |
Location: | JIOSE |

ui  Choose a Driver...

Auto Select

l Other...

06. Select the "Jiose Label Printer" and click "Ok" to continue.

Add

8@

Dafault 1P Window Search

(QFiter |
[P Photosmart Prem-Web Ca08ms. Fox |
HP Photosmart Premium C309g-m
hp psc 2400 series. Fax

hp psc 2500 series. Fax

Intellitech IntelliBar Label Printer, 2.3
Oki 24-Pin Series.

Oki 9-Pin Series

Zebra CPCL Label Printer

Zebra EPL1 Label Printer

Zebra EPL2 Label Printer

Zebra ZPL Label Printer




07. Click "Add", and the Jiose J500 (Automatically identify the printer model.)
printer is added to your computer successfully.

Name « Kind |
-
|
|

JIOSE J500

JIOSE
Jiose Label printer C .

Options & Supplies...

Sharing Preferences...

OK, the driver installation is finished, you may close the window and learn
how to set the parameters to your most used or try to print a sample
shipping label.



ChromeOS INSTALLATION
&PRINTING SETUP GUIDE

1. Go to Chrome Web Store, search for "Flashlabel Extension".

(https://chrome.goole.com/webstore/category/extensions)

e0e M Extensions X @& ChromeWebStore-E X G Signin-Gog
[

c [ﬂ chrome.google.com/webstore/category/extensions ]

~ chrome web store

flashlabel
flashlabel extension

2. Add FlashLabel Extension to Chrome.

& chrome web store &
Home > Exensions > Fashlabel Extesion
H FlashLabel Extension
% % % % % O | Productivity | 1users
oo ) Pesipasme  Ravews Reeted




3. Click on the FlashLabel Extension to open the setting page

and click Add.

*TF

& chrome web store

Home > Extensions > FlashLabel Extension

B Fasabe exonson

H FlashLabel Extension

kK K O | Productivty | 1users

Add FlashLabel Printer Setting Printer

“.insert printer and click Add button to enter the device list, then
Select the printer
2.0pen the file to print

3.Please do not close this web page. After closing, you
will not be able to select flashprinter.

4. After the printer is added successfully,if you close

this web page accidentally, you can reopen this web
page without adding a printer again

4. Select "Printer" (or shown as "Unknown device from
Memory Corp" ) and click on Connect (Remember to connect
the printer USB port to the computer and turn on the printer).

. @MEBEQe®oc» o

T ex
“w @0

o 509




5. You are all set now, please choose Flashlabel as destination
and print the labels you need!

4 N

» Notes

1. Theres is no need to configure the printer when the
configuration notification pop-up after setting up since we
are using the extension to add printer to Chromebook;

2. Please open the extension page and keep the page
active when printing;

3. The Flashlabel Extension is developed for ChromeQS,
not for Chrome Browser in Windows or MacOS.

- /




_ e\

> QIl:What can I do if there are white spots in my print?

>

AT: The printer head may be dirty. Please follow the steps below to
clean the printer head.

<1> Turn off printer and wait for it to cool down ;

<2> Use alcohol pads and wipe the printer head starting from
themiddle and end on both sides ;

<3> Wait 3-5 mins for the alcohol to vaporize.

Note: If the same issue is still occurring after you've cleaned your
printer according the steps above. Please contact us.

Q2: When the printing is not sharp / dark, how to adjust
the density and printing speed?

A2: Try to adjust your printing speed. (If the printing speed is set
too high, and darkness too low, labels may come out faint.)

For Windows: go to "Printer Preferences" -> "Page Setup" and
lower the speed or increase the darkness.

For Mac: go to File > Print, to access the Darkness and Speed
options, you need to switch from "Preview" to "Printer Features"

Q3: How to crop a full size 8.5" x 11" page to a 4" x 6" label?

A3: Two suggestions could help you print the 4" x6" label:

<1> Set the format to 4"x6" in the background of the platform and
regenerate the PDF before printing.

<2> Use the snapshot function of Adobe Acrobat Reader
software (which is free) to cut and print the label to 4"x6"



>

Q4: Printer is skipping labels or continuously feeding?

A4: There are two main reasons why this is happening:

<1> The printer has not yet learned the size of your label (most
common). To fix this, press and hold the "feed" button until you
hear one "beep" to run the "Intelligent Label Study" mode.

<2> The page size set in the driver is larger than the actual label
stock. Please adjust your label size through settings.

For Windows, go to "Printer Preferences" -> "Page Setup" and
adjust the label size to match the actual label size. The default
value is typically 4x6 inches.

For Mac, you can change the label size during the printing
interface.

Q5: Why does the printer print blank labels?

A5: It may be caused by the following reasons, please check step
by step:

<1> When inserting labels into the printer, make sure the label is
facing the upper side.

<2> Please make sure to use "Direct Thermal" labels, as "Thermal
Transfer" labels can not be used on a direct thermal printer, even
though they may appear similar.

<3> Check that the printer cover is tight.

<4> If the above steps didn't help. Please press and hold the
"Feed" button for 3 secs until you hear a "Beep" and run the
"intelligent label study" mode.

» Note

You may also visit our official website to get the tutorials
or look them up on YouTube by searching.




PRO TIPS \

> Each time you change your label, run the automatic label
identification.

> Press the feeder button on the printer to skip a blank
label.

> To run a self-test, press and hold the feeder button until you
hear two short beeps.

> Avoid poor quality labels as they may damage the printer.

> Regularly clean the printer head.

> If paper is jammed, turn off the printer, and allow the printer
head to cool down. Open the cover and ensure that the
rubber is clean. If dirty, use alcohol to clean the head. Allow
the area to dry off before turning the printer on.

> Connect the printer to the same USB port on your computer
every time. This will avoid creating duplicate copies of the
printer in your operating system.

—_ 29 —



PREFERENCE SETTING \

This section helps Windows and Mac users effortlessly
locate the configuration options for customizing the page
size, print speed, and density (darkness) of labels.

For Mac:

Open the Print dialog box by
selecting File > Print, to access
the Darkness and Speed
options, you need to switch
from "Preview" option to "Printer
Features'

» Note:

If the printed content is not centered enough, the
Horizontal and Vertical options can be adjusted to shift
the printed content accordingly.

For Windows:

Go to the "Control Panel" (or
"Settings” for Win11) find
"Printers and Devices", right
click on "Jiose J500"(or other
model) , select "Printing
preferences " > "Page Setup"




SPECIFICATION \

Method Direct Thermal
Resolution 203 dpi, 8 dots/mm

Max Printing Speed 180 mm/s (7 inch/s)

Paper Width 40~110 mm (1.57"~4.3")
Paper Thickness 0.06~0.254 mm

Power Adapter DC 24V/2A

Pinting Life TPH 100 KM
Connection USB / Bluetooth

Weight 159 Ibs / 0.72 kg
Dimensions 176x 110x 93mm (L*W*H)

Windows/Mac os (Print via USB cable)

Supported System : : .
iOS/Android (Print via Bluetooth)

Operating Temperature: 0 to 45°C
Environment Humidity: 10% ~ 80%
Storage Temperature:-10 to 50°C

Environnent Humidity: 10% ~ 90% (Non condensing)



MAINTENANCE \

Printer Head Cleaning Steps:

> Turn off the printer and unplug the power cable. Open
the cover.

> Wait until the printer head cools down. It can be very hot
after printing.

> Use an alcohol swap (not water) to completely clean
the printer head.

> Wait until the alcohol has completely vaporized, then
close the cover.

> Connect the power cable and print a test page to check
if it is clean.

» Note

Ensure power is off when performing maintenance.
Do not touch or scratch the printer head surface, roller, or sensors.
Avoid gas, acetone, or other organic solvents.




SAFE NOTICES \

> The printer head can become very hot after printing
labels. Do not touch the printer head.

> Do not bend the power cable excessively or place
objects on the cable.

> Do not use the printer if you find any irregularities as
these could result in fire or electrocution.

> Use only approved accessories and do not try to
disassemble or repair the unit by yourself.

> Keep the printer away from water and other objects that
could penetrate the components.

> Please unplug the printer when it is not in use for long
periods of time.

33—



SUPPORT AND WARRANTY \

Your Jiose printer is covered by a one-year warranty.

You're welcome to visit our website: www.jioseprinter.com

to get the live support, latest driver, platform setup guide and
FAQs.

@ Jiose Email: support@jioseprinter.com
LiveChat: www. jioseprinter.com (Recommend)

. Jiose Tel: +1 281-236-7202
+1281-845-2738

Service Hours: Weekdays from 9:00am to 18:00pm PST.

Scan QR Code below to CONTACT Jiose TECH SUPPORT
Directly or email support@jioseprinter.com

Website

Jiose J500 v2.04
34—



